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CAUTION:

® Operate this equipment according to the operating procedures described in this manual.

® Use only the provided CD-ROM. Never use any other CD-ROM to run this software.

® Do not attempt to modify this software.

® Changes or modifications not approved by JVC could void user’s authority to operate the equipment.

How to handle a CD-ROM

® Take care not to soil or scratch the mirror surface (opposite to the printed surface). Do not write anything
or put a sticker on either the front or back surface. If the CD-ROM gets dirty, gently wipe it with a soft
cloth outward from the center hole using a circular motion.

® Do not use conventional disc cleaners or cleaning spray.

® Do not bend the CD-ROM or touch its mirror surface.

® Do not store your CD-ROM in a dusty, hot or humid environment. Keep it away from direct sunlight.

® You can find the latest information (in English) on the provided software program at our world wide web
server at http://www.jvc-victor.co.jp/english/index-e.html

® Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft Corporation in the
United States and/or other countries.

® Macintosh is a registered trademark of Apple Computer, Inc.

® Keyspan is a trademark of InnoSys Inc.

® Other product and company names included in this instruction manual are trademarks and/or registered
trademarks of their respective holders.



4 N INTRODUCTION

I Reading this document

This document consists of the following three sections and an Appendix.
Before use, please read the Setup Guide for preparation.

m Loading Still Images (Windows®)

This section explains how to capture images from the camcorder tape to the PC. This section also explains
how to load still images into the album of the Digital Photo Navigator software.

m Playing Back and Handling Images (Windows®)

This section explains how to handle still images using the Digital Photo Navigator software. You can send still
images by e-mail and store an album as a web page.

m Digital Photo Navigator (Macintosh)

This section explains how to capture images from the camcorder tape to the PC.

m Appendix

This appendix contains troubleshooting and index.
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Loading Still Images (Windows®)

You can capture still images from the recorded camcorder tape or load still
image files from the hard disk in the PC. The Digital Photo Navigator
software allows you to store and view still images in a photo album format.
The icons on the Digital Photo Navigator window have the same functions
as the menus. In this section, almost all the procedures are explained using
the icons.

Read this section if you are using a Windows® operating system.

[>~Digital Photo Navigator [_[Ofx]
Menus File Edi Impot Expor Window Help
kwd
Import ¥ Export
I [ —
cons — )2

Alburm Image

@

Camcorder
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CAPTURING IMAGES

You can capture still images from the recorded camcorder tape, or load still image files from the hard disk in
the PC. After capturing or loading images, create an album that contains a collection of still images.

Preparation

1 Connect the camcorder to the PC with the PC connection cable.
® Refer to “CONNECTIONS (Windows®)” (= pg. 6) in the Setup Guide.

2 Select [Start] — [Programs] — [Digital Photo

Navigator] — [Digital Photo Navigator 1.0].

Digital Photo Navigator starts.

® Close any other programs running on the PC.

® Disable any programs that run in the background, such
as screen savers, e-mail applications, virus checkers,
schedulers, etc.

® Turn off file and printer sharing.

I Capturing still images from tape

You can capture still images from the camcorder tape on the PC.

1 Set the Power Switch on the camcorder to “ E¥M”.
The camcorder is now on.

2 Click [Import].

3 Click [Camcorder]. The Controller window appears.

NOTE:
If the camcorder is not connected to the PC, the camcorder is
turned off, or the camcorder is connected to any serial port
other than COM1, the [JLIP Devices] dialog box appears.
1) Connect the camcorder to the PC with the PC connection
cable.
® Refer to “CONNECTIONS (Windows®)” (= pg. 6) in the
Setup Guide.
2) Set the Power Switch on the camcorder to “ G¥33”.
The camcorder is now on.
3) Select the appropriate setting for [Serial Port] depending on
the port in use.
4) Click [Scan].
5) If the camcorder name [VCRCAMERA] appears, click [OK].

New Office Document
L7 Open Ofice Document

%W\

indows Update

Pro

-]

Favarites
¥ Documents
& setings
Al End
@ Help
Eun
€2, Log OffShinnko,
EH &) shutoown
[#Start || @ &)
Fils, dit Importt Export Window Help
=
Export
=i
Image
JLIP Devices [ ]
Serial Port Picture Transfer Rate
= [115200 =]
Selected Device
WCR|ID:06 VCRCAMERA (il
Sean|ro Device SElEet
No.‘\D |Category ‘Name ‘ can
Mot Connected
1 06 Camcorder VCRC
QK Cancel

CONTINUED ON NEXT PAGE



CAPTURING IMAGES (cont.) EN /

4 Click the B button in the Controller window.
® Playback of the camcorder tape starts.

S Click the Capture button when the desired image
appears.
® The image is transferred to the PC and thumbnail image
appears to the right-hand side of the Digital Photo
Navigator window.

Capture

6 Repeat steps 4 and 5 to capture additional images.
® |t is possible to capture or add up to two hundred images into an album.

7 Click [Export] after capturing is completed. [0 i s BRE

8 Click [Album].
The [Save As] dialog box appears.

9 Specify the location where you want to save the
album, input the file name of the album, and then
click [Save].

The album is saved.

web
Page

a
e
o If you save an album for the first time after the software
installation, a message appears and asks if you want to () I e s e o
register the association of the file extension name “jia”. PO G e
Then, click [Yes]. [ oves Mo

® To exit Digital Photo Navigator, refer to “Exiting Digital
Photo Navigator” (= pg. 14).
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Controller window

Fast Forward (p)

Time code

Play (») Close

Rewind (44)
Automatic Capture
Pause (1)

Slow Rewind Capture

Reverse Frame Advance

Slow Forward

Stop (H) Forward Frame Advance

NOTES:

® Use only the operation buttons in the Controller window to control the camcorder. If you operate the
camcorder with its own operation buttons, the appearance of the Controller window may not correspond to
the status of the camcorder, or it may cause a malfunction to occur in Digital Photo Navigator.

® The Controller window may appear to still be operating the camcorder even after the videocassette
automatically stops at the beginning or end of the tape. In this case, click the Stop (B) button in the
Controller window before performing another operation.

® [f an image is captured in the Pause or Slow Play mode, some noise may appear on the captured image. In
this case, capture the image during normal playback.

I Automatic Capture

You can automatically capture still images from the camcorder tape on the PC according to your preferences.
There are 2 ways available: “Photo Capture” and “Interval Capture”.

1 Set the Power Switch on the camcorder to “ E¥X”.
The camcorder is now on.

2 Click the ® button in the Controller window.

3 Click the Automatic Capture button. >
The camcorder enters still playback mode. Automatic
Capture

CONTINUED ON NEXT PAGE
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4 Co to steps in “Photo Capture” or “Interval Capture” below.
NOTES:

® Depending on your PC’s specifications and operating environment, the points where images are captured
may not match what was set in the preferences.

® [f the videotape is damaged, the points where images are captured may not match what was set in the
preferences.

® Automatic capture may not function properly if portions of the videotape are unrecorded.

® Automatic capture cannot be performed in the time code range from 00:00:00:00 to 00:00:30:00.

® Automatic capture stops when the number of images in the right-hand side of the Digital Photo Navigator
window reaches 200 or the videotape ends.

Photo Capture
You can capture only snapshot images recorded on a tape.
1 Select [Photo Capture] in the Automatic Capture SRR
window. & Fhoto Copture Number of Images
2 Set the number of images to be captured. I Gerefoter o =
3 Click [OK]. The camcorder starts forward search and  Inerval Captue
capturing is performed when each snapshot image is we —
found out. N —
e If you want to start the search from beginning of a tape, |
select [Rewind the tape] before clicking [OK]. Number of images
4 Click [Export] after capturing is completed. Rt gt st e s Bk

A
Import

S Click [Album].
The [Save As] dialog box appears.

6 Specify the location where you want to save the
album, input the file name of the album, and then
click [Save].

The album is saved.

web
Page

5 o7 008

Change
Format

o If you save an album for the first time after the software
installation, a message appears and asks if you want to
register the association of the file extension name “jia”.
Then, click [Yes]. T

® To exit Digital Photo Navigator, refer to “Exiting Digital
Photo Navigator” (= pg. 14).

NOTE:

Photo Capture may not function properly when, for example, the camcorder tape includes snapshot images
recorded after the recording speed was changed, or when snapshot images were continuously recorded. In
these cases, capture images by performing the steps in “Capturing still images from tape” (= pg. 6).

The file extension name 'jia' dossn't sssociate with this proeram
Do you want to register the association now
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CAPTURING IMAGES (cont.)

Interval Capture

You can capture images at specified intervals. This function is useful for summarizing the contents of a tape,

or for watching time-lapse movies using the slide show.

1 Select [Interval Capture] in the Automatic Capture
window.

2 Set the number of images to be captured.

3 Set the length of the interval (in minutes and
seconds).

4 Click [OK].

5 Click [Export] after capturing is completed.
6 Click [Album].
The [Save As] dialog box appears.

7 Specify the location where you want to save the
album, input the file name of the album, and then
click [Save].

The album is saved.

o If you save an album for the first time after the software
installation, a message appears and asks if you want to

register the association of the file extension name “jia”.

Then, click [Yes].
® To exit Digital Photo Navigator, refer to “Exiting Digital
Photo Navigator” (= pg. 14).

NOTE:

¢ Photo Capture Number of Images

™ Rewind the tape 15 2

* Interval Capture

_IG l@ Cancel

Length of the interval Number of images

[>Digital Photo Navigator 5]
File Edit Ipaage Export Window Help

Y ol |
i
EMal Ml
Image
web Mavie
Page =
5 o7 008

Change
Format

The file extension name 'jia’ doesn't associate with this program
Do you want ta register the association now?

This function doesn’t work if there is no time code recorded on the videotape or if the recording time is

shorter than 1 minute.
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I Changing the transfer speed

The default setting is 115200bps. Depending on the PC in use, transmission errors may occur. In this case,
change to a lower serial speed setting, however, the rate of image transfer will be slower.

1 Right-click the Controller window and then, in the menu that appears, click [Device Setting].
The [JLIP Devices] dialog box appears.

2 Select the desired setting for [Picture Transfer Ratel. JLIP Devices ]
i Serial Port PFicture Transfer Ratd
3 Click [OK]. [comr =] N\ [rise00 =]

Selected Device

WCR|ID:06 VCRCAMERA et
Sean|MNo Device SElEet

can

No.‘\D |Category ‘Name
il

1 06 Camcorder v

QK Cancel

I Changing the ID number

When two or more camcorders are connected to the PC, be sure to change the ID number between 1 and 99
for the connected camcorder that there is no duplication of ID numbers. The default ID number is 06.

1 Right-click the Controller window and then, in the menu that appears, click [Device Setting].
The [JLIP Devices] dialog box appears.

2 Right-click the number in the list box, then click
Change ID]. Serial Part Picture Transfer Rate
[ 8 ] [comt = [irsem 5]
3 Input the ID number and press Enter key. o
4 C||Ck [OK] WCR|ID:06 WCRCAMERA Select
' Sean|o Device Selest
NOTE:
Refer to the Instruction Manual of the connected camcorder for No.[ID[Categary \EBWCE |

details on changing the ID number of a camcorder. 06 Jameordar ¥

OK Cancesl




12N ADDING STILL IMAGES TO AN ALBUM

You can load the still image files (bitmap or JPEG format) from the hard disk in the PC to an album.
1 Start Digital Photo Navigator.

2 Click [Import]. ETZ—-—
3 Click [Image]. =

The [Open] dialog box appears.
4 Open the folder that contains the desired still images. a2

Camcorder

Open [21x]
Lookin: | &3 1000VCGR - =
A Desktop _
Dvcon| 3 My Documents
Dvcoo| 2 My Computer
&8 3% Floppy (A)
=20
& o)
i Remavable Disk (E)
G pemM
E 1100.vCGRS
i Network Neighborhood
File name] (3 My Briefcase —
(3 Online Senvices
Files oftype:  [Image File | Cancel
4
5 Select the desired still image files and click [Open]. = Digt Phots Nagator e

File Edit Impot Export Window Help

The still images are added to the right-hand side of m' G -
the Digital Photo Navigator window. L % E =

® You may select more than one file. a =
® You can also add files by dragging and dropping them in s
the Digital Photo Navigator window. &
6 Add additional still images as desired by repeating
steps 3 - 5.

CONTINUED ON NEXT PAGE



ADDING STILL IMAGES TO AN ALBUM (cont.) eN 13

7 Click [Export]. > Digial Photo Novigotor ——

8 Click [Album].
The [Save As] dialog box appears.

9 Specify the location where you want to save the
album, input the file name of the album, and then =
click [Save]. RN
The album is saved. W_E|b| ﬁ
2

o If you save an album for the first time after the software
installation, a message appears and asks if you want to

The file extension name jia' dossr't sssaciats with this program
ts

register the association of the file extension name “jia”. gt Wl (i el ey
Then, click [Yes]. RGN

® To exit Digital Photo Navigator, refer to “Exiting Digital
Photo Navigator” (= pg. 14).




14N EXITING DIGITAL PHOTO NAVIGATOR

1 Click the [File] menu and then click [Exit]. File
e [f you have already saved an album, a confirmation message Mew

appears. Then, go to step 2.

e If you have not saved an album after capturing or loading
still images, a confirmation message appears.
To save an album, click [Yes]. The [Save as] dialog box @ The album has not been saved.
appears. Specify the location where you want to save the Save ?

album, input the file name of the album, and then click
[Save]. A confirmation message appears. Then, go to step 2. T Ves o |
To exit Digital Photo Navigator without saving an album,
click [No]. A confirmation message appears. Then, go to
step 2.

2 Click [Yes]. Digital Photo Navigator B

Digital Photo Navigator closes.

@ Close Digital Photo Mavigator?

[ila] |
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Playing Back and Handling Images (Windows®)

This section explains how to handle still images using Digital Photo
Navigator.

You can send still image files as an e-mail attachment and store an album
as a web page. Be sure to read “Loading Still Images (Windows®)” before
reading this section.

The icons on the Digital Photo Navigator window have the same functions
as the menus. In this section, almost all the procedures are explained using
the icons.

Read this section if you are using a Windows® operating system.

[>~Digital Photo Navigator [_[Ofx]
Menus File Edit Import Export MWindow Help

b s
Import

|

Icons— Hl &

Abum Image

B ol |

a3

E-Mal Multi

Image

Webh Movie
Page
Change
Farmat.
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LOADING AN ALBUM

1 Start Digital Photo Navigator.
2 Click [Import].

3 Click [Album].
The [Open] dialog box appears.

4 Open the folder where the album was saved.

5 Click the desired album file, and then click [Openl.

The contents of the album are displayed in the right-hand
side of the Digital Photo Navigator window.

NOTES:

[>Digital Photo Navigator 5]

Wy Import Export Window  Help
.
~24
Export
i) &
Abum ) Tmage

Camcorder

Open [21x]

okin [@oveen 5@ @l o

i Network Neighborhood

Fileneme| (5 My Brieicese —
(2 Online Services
Files oftype:  |Image File -] Cancel
4
[>Digital Photo Navigator S
File Edit Import Export Window Help
. ; =
=22
Import Export
3 = A b
ﬂ a o0t 002 003

Album Image

Camcorder

® You can also open the album file by dragging and dropping it in the Digital Photo Navigator window.

® [fan album is currently open, a confirmation message
appears.

* If you want to open the newly selected album instead of

the one already opened, click [Yes]. If you have not saved

the album already opened, a confirmation message
appears. If you want to save the album, click [Yes]. If you
do not want to save the album, click [No].

Digital Fhoto Navigator

@ Do you wantto delets the images already existed?

Yes Mo |

e If you want to add still images from the newly selected album to the album already opened, click [No].
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I Displaying a selected still image

You can select for display any of the still images that are displayed in the right-hand side of the Digital Photo
Navigator window.

1 Double-click the still image to be displayed.
The [Image Viewer] window appears, and the selected image is displayed.

-~ Image Viewer [ Image002 35% |

[
0 R e S A

EE

I Displaying a series of images

To display a series of images in “slide show” fashion, click the | button in the [Image Viewer] window. You
can also move through the images manually in either direction by clicking the i/ and x| buttons.

Stop slide show Start slide show

[ 1| r| |>| [m |11
|

First image

Last image

Previous image Next image

To adjust the speed of the slide show, right-click the [Image Viewer] window and then, in the menu that
appears, click [Slide show] — [Setting Interval Time]. Set the length of the interval (in seconds), and then click
[OK].

NOTE:

The interval for a slide show is a little longer than the setting because of display processing time.
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I Enlarging and reducing images

The following procedure describes how to change the display size of a still image.

1 Dragthe corner of the [Image Viewer] window to change the size of the window to the desired
display size.

2 Right-click the [Image Viewer] window and then, in the Display magnification
menu that appears, click [Zoom] — [Auto].
The size of the still image is automatically enlarged or reduced to
fit the window, and the display magnification (enlargement/
reduction percentage) indicated in the title bar of the window
changes accordingly.

Other enlargement /reduction functions

In addition to adjusting the size of the image to the size of the
window, the display size of a still image can also be changed by the
methods described below. Each of these functions can be selected by
right-clicking the [Image Viewer] window.

® [Zoom] — [Real Size]: Displays the image in its original size (display magnification of 100%).

® [Zoom] — [Zoom In]: Displays the image at twice its current display magnification (up to 400%).
® [Zoom] — [Zoom Out]: Displays the image at half its current display magnification (up to 20%).
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Whenever necessary, you can delete or copy still images that you have added to an album. The procedure
described below only affects the still image in the album. It does not affect the original file of the still image
that was added to the album.

I Selecting multiple still images

To delete or copy multiple still Images at once, select them in advance. You can also select all still images in
the album.

Selecting still images continuously
Click still images while holding down the Shift key.

[_[CIx]

Shift + Click

2 3

E &&=
B

EMal bt
Imag
web [
Page
5 o7 008
Change
Format

Selecting still images one by one
Click still images while holding down the Ctrl key.

- Digital Photo Navigator
Import Export Window  Help

Ei

Ctrl + Click

Selecting all of the still images
Click [Select All] in the [Edit] menu.

Edit
(Euf (01t
Cpy (Lt
Paste (EfH s
elete =]

Crl+4,

|hiverse Selectian
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ORGANIZING ALBUMS (cont.)

I Deleting unnecessary still images

1 Click the still image that you want to delete, and then
click [Delete] in the [Edit] menu.
A confirmation message appears.

2 Click [Yes].

The selected still images are deleted.

I Copying still images

1 Click the still image that you want to copy, and then
click [Copy] in the [Edit] menu.

2 Click the image that is located right after the
insertion point.
® To add the images at the end of the album, click the blank
space in the right-hand side of the window.
3 Click [Paste] in the [Edit] menu.
The copied still images are inserted right before the selected
image.

NOTE:
You can delete, copy or paste an image also by right-clicking it.

TEdit’
Cut Cirl+
Copy Ctrl+C
Paste (EfH s

Select All Cirl+A,
Inverse Selection

Digital Photo Navigator

@ Delete 1 Image(s) 7

Select All Cirl+A,
Inverse Selection

[~ Digital Photo Navigator M=
File | Edit Import Export Window Help
Cu Cir

Insertion point



SENDING IMAGES FROM AN ALBUM IN E-MAIL

Click the still image that you want to send, and
then click [E-Mail].

The new message window in your e-mail program
appears, and the still image file is registered as an
attachment.

NOTES:

® Depending on an e-mail software, a new message window
may not open when the [E-Mail] button is clicked.

® Depending on an e-mail software, settings such as “Set as
MAPI client” or “Used by MAPI application” are necessary.

® The maximum number of messages that can be created at
once is three.

Still images in an album can be sent as an e-mail attachment.

- Digital Photo Navigator

File Edit Impot Export Window Help
A
Import

=]

Album Image

=
Multi
IEl

]

Change
Format

[_[CIx]

i New Hessage

it View Inset Fomal Took Messsge Help

[_[O]x]

ENE

Gt Gom) Paste s

a v

Check_Speling

Sign Encypt Ofine

@ |

@ee [

subiet [

Attach twmnnnnmannxm i

NS
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CREATING A WEB PAGE

You can save the contents of an album in HTML format. This is useful in the following instances:

When creating a web page: You can create a web page that features a collection of photos.
When distributing an alboum:  You can create an album in a format that can be displayed by a web
browser. This is useful if you want to distribute the album on CD-R, etc.

1 Select the still images that you want to save in HTML
format.
® To select more than one still image, hold down the Shift
key or the Ctrl key while clicking the images.
® To select all of the still images, click [Select All] in the
[Edit] menu.

2 Click [Web Pagel.
The [Web Page] dialog box appears.

3 Set the following items when necessary.

e [Title]: This will be the title of the web page.

@ [Font Color]: This specifies the color of the title text.

® [Back Color]: This specifies the background color of the
web page. (Specify a color other than the font color.)

® [Limit horizontal size of the images]: This allows you to
specify the maximum width of the image when displayed
by a web browser. (Set the number of pixels much smaller
than the width of the PC’s display.)

[~ Digital Photo Navigator M=
File Edit Impon Export Window Help
A
Import

Abum
Etal
web
Page
change
Format
Web Page [x]
Tl
My Pictures
Back Calor
Imag
¥ Limit horizortal size of the images
Masimurn pivels [0 2]

CONTINUED ON NEXT PAGE
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4 (Click [OK], specify the save location, and then
click [Savel]. @ ﬁ,
The HTML file is saved, and a folder with the same pagelllhtm page00l
name is saved at the same time. A confirmation
message appears next, asking whether to display the

web page.
5 Click [Yes]. My Pictures - Microsoft Internet Explorer AEE
) File Edit View Favortes Tools Help ‘
The web browser opens, and the HTML file that was + . = . 0 o a 3 | B
ted iS dis ]a ed Back Farward Stop Refresh  Home Search Favorites  History Mail Print
crea p y . Address [ C:\My Documents\page001 him =] @co |[Links

® Click on an image on the web page to enlarge it.
My Pictures

& [ [ [BMWCompuer

What Next?

You can also view an HTML file through the web browser by double-clicking the HTML file. You can upload
the HTML file to your home page, or save it on a CD-R or some other media and distribute it.

Always handle HTML files and folders as a set. Without its folder, an HTML file cannot be viewed by a web
browser.

NOTES:

® For more details on how to create a home page, consult your Internet service provider’s web site or one of
the many reference books available.

® Use third-party home page creation software or similar software to edit HTML files.
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I Changing the image size

This procedure describes how to change the size of an image that has been loaded into Digital Photo
Navigator. This procedure is used to reduce the size of an image that is being attached to an e-mail or saved in

an album.

1 Select the still image to be changed.
® To select more than one still image, hold down the Shift
key or the Ctrl key while clicking the images.
® To select all of the still images, click [Select All] in the
[Edit] menu.

2 Click [Change Format].
The [Image Format] dialog box appears.

3 Select one of the following items:

® [Expansion/Reduction]: Set any desired image size in the
[Width] and [Height] fields. If the [Keep aspect ratio]
check box is not selected (off), both [Width] and [Height]
fields can be changed.

® [Generic Sizel: Select the size from a list of generic sizes.

® [PDA Size]: This is an image size (160 x 160) that can be
displayed on most PDAs.

4 Click [OK].
o [f you select more than one still image instep 1, a
confirmation message appears.

¢ If you want to apply the same format to all images, click
[Yes].

- Digital Photo Navigator
File Edit Impot Export Window Help

[
Impart
H =
Album Image
o1
2
E-Mail Multi
Web Mavie
e/
Change

[_[CIx]

Image Format
Image Size

‘idth (540 3: Height |50 3:

" Keeplmage Size

© Expansion/Reductior
¥ {{een epect retin

© Generic Size Bdlx 480 =
- B0x B0

PDA Size 160%120
320x 240

JPEG Quali i B4l 481
R et
R Frven)

1280x 960
16001 200

80 degress Rotation—
& None
© Clockwise

© Counterclockwise

~Image Correction{Civ)-
& None

€ Movement
€ Field

Format
JPEG B

Cancel

¢ If you do not want to apply the same format, click [No]. The first image is saved. Then, select the image

size for each image.

The image size is changed to the selected size. If the vertical-to-horizontal ratio was changed, the blank

spaces are shown as black.



CHANGING THE IMAGE SIZE OR PICTURE QUALITY (cont.) EN 25

I Changing the picture quality, etc.

In addition to changing the size of an image, it is also possible to rotate images, change or correct the quality
of an image, and change the file format of an image. The role of each setting is described in more detail
below.

[90 degrees Rotation]

If you hold the camcorder sideways when recording an
image, you can create an image that is taller than it is
wide. Because this still image will be displayed sideways,
use this function to rotate the image 90 degrees to the
portrait orientation.

[None]: No correction

[Clockwise]: Rotates the image 90 degrees clockwise.
[Counterclockwise]: Rotates the image 90 degrees
counterclockwise.

[Image Correction (DV)]

Sometimes, when you shoot a subject that is moving very quickly, the resulting image will be blurred. It is
possible to correct this blurring to a certain extent. Because the optimal type of correction depends on the still
image, we recommend making a copy of the image and experimenting with the copy. It is not possible to
correct for blurring caused by shaking the camera while shooting.

[None]: No correction

[Movement]: Corrects only the blurred portions.

[Field]: Corrects blurring more quickly than [Movement].

[Format]

You can select the file format of an image.
[JPEG]: This is the format that is typically used on the Internet. This format has a smaller file size.
[BITMAP]: This is the standard Windows® image format (BMP). Many applications can use this format.

[JPEG Quality]

This setting is available when JPEG was selected in the [Format] field. Moving the slider to the left makes the
file smaller. Moving the slider to the right results in less deterioration in the image quality. The initial setting is
75.

NOTES:

® When [JPEG] is selected in the [Format] field, the quality of the image deteriorates slightly each time that
[OK] is clicked for the [Image Format] dialog box. To restore the original image quality, reload the original
still image file.

® The setting in the [Image Correction (DV)] field has an effect only when the still image was shot with a
digital video camera.

® When you shoot a subject that is moving too quick, some blurring cannot be corrected with the setting in
the [Image Correction (DV)].

® When [Field] is selected in the [Image Correction (DV)] field, the quality of the original image deteriorates.

® 7o confirm the file size, right-click the still image and then select [Properties].
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You can retrieve still images from an album and save them as a file.

[>Digital Photo Navigator 5]

1 Select the still image to be retrieved. T —
® To select more than one still image, hold down the Shift .
key or the Ctrl key while clicking the images.

=
-
5]

]

Mavie

® To select all of the still images, click [Select All] in the g
[Edit] menu. aum
2 Click [Image].

The [Image Format] dialog box appears.

JEl

web
Page

e
o
3 Change the image format as desired. (= pg. 24, 25) Image Format
. Image Size 890 degress Rotation
Then, C|ICk [OK] W?dm 0 2] Height [50 2] g ang
The [Save As] dialog box appears. € Keep Image Size £ e
. . ) (_ Counterclockwise
4 Specify the location where you want to save the file, S ean eoperrats A s——
input the file name, and then click [Save].  Gereictiie [eamam 5] ;;m‘
The image file is saved. € POASRe © Fild
o If you select more than one still image instep 1, a JFEG Quaty Form
confirmation message appears. IR
* If you want to save all images with the same image el

(

format and their default name, click [Yes]. The [Auto
Save Result] dialog box appears. Then, click [OK].

¢ If you want to set the image format and input file name
for each image, click [No]. The first image is saved. The
[Image Format] dialog box appears for the second
image. Repeat steps 3 and 4 as many times as necessary.




CREATING A LIST OF STILL IMAGES

You can arrange multiple still images together and save them in a single still image file.

1 Holding down the Shift key or the Ctrl key, select the
still images that are to be added to the list.

2 Click [Multi Image].
The [Multi Image] dialog box appears.

3 Select the number of partitions.
® Either 4, 9, or 16 partitions may be selected.

4 Click [Back Color], select the color for the overall
background, and then click [OK].

5 Change the positions of the still images as desired.
® Deleting an image: Right-click the still image and then
select [Delete].
® Adding an image: Drag an image from the right-hand side
of the Digital Photo Navigator window to the [Multi
Image] dialog box.
6 Click [Save].

The [Image Format] dialog box appears.

7 Change the image format as desired. (= pg. 24, 25)
Then, click [OK].
The [Save As] dialog box appears.

8 Specify the location where you want to save the file,
input the file name, and then click [Save].
The still image list file is saved.

- Digital Photo Navigator
File Edit Impot Export Window Help
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[>Digital Photo Navigator 5]
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CREATING A SLIDE SHOW OR AN ANIMATION

You can create a slide show or an animation in which a series of still images are displayed, and then save

those images as a movie file (extension “.avi”).

[Slide Show]: Still images are displayed for several seconds each, one at a time.
[Animation]: Several still images are displayed per second. We recommend that you select a series of still

images that create the appearance of continuous movement.
1 Holding down the Shift key or the Ctrl key, select
several still images.
2 Click [Movie].
The [Movie Settings] dialog box appears.

3 Select either [Slide Show] or [Animation], which ever
is desired.

® For a slide show, set the length of the interval (in seconds).

® For an animation, set the number of displayed frames
(images) per second.

4 set the following items when necessary.
® [Image Size]: Select the size of the movie file.
® [Compressor]: Select the type of compressor.
® [Back Color]: This item is used if the aspect ratio of the
images is not 4:3.

S Click [OK].
The [Save As] dialog box appears.

- Digital Photo Navigator

File Edit Impot Export Window Help

2

EMal

JEl

web
Page

3

Change
Format

Movie Settings
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 Slide Show

& {Animtior

2 2] Frames/Sscond

Back Colol

Image Size
( [wan & _Change |
Compressor

Cinepak Codec by Radius

Chonge| | _Cancal |

6 Specify the location where you want to save the file, input the file name, and then click [Save].
The movie file is saved, and a confirmation message that asks if you want to play the movie now appears.

7 Click [Yes].
The movie file is played back.
NOTES:
® If you change the [Compressor] item, make sure that the
playback system supports that type of compressor.

® Depending on the selected type for [Compressor], a movie file

cannot be created.

Digital Photo Navigator

@ Do you want to play the Movie now?

® [n some cases, the settings in the [Video Compression] dialog box are invalid.
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Digital Photo Navigator (Macintosh)

You can capture still images from the recorded camcorder tape. The Digital
Photo Navigator software allows you to store and view still images in the
hard disk of the PC.

The icons on the Digital Photo Navigator window have the same functions
as the menus. In this section, almost all the procedures are explained using
the icons.

Read this section if you are using a Macintosh operating system.

Digital Photo Navigator

00:03:48:07F

S i)
RIS
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Preparation

1 Connect the camcorder to the PC with the PC connection cable and the USB PDA ADAPTER.
® Refer to “CONNECTIONS (Macintosh)” (= pg. 9) in the Setup Guide.
® Never disconnect the PC connection cable or the USB PDA ADAPTER while Digital Photo Navigator is
running.
2 Open the [Digital Photo Navigator 1.0] folder.
® Close any other programs running on the PC.
® Disable any programs that run in the background, such as screen Digital Photo Navigator 1.0
savers, e-mail applications, virus checkers, schedulers, etc.
® Turn off file and printer sharing.

3 Double-click the [Digital Photo Navigator] icon.
The port selection dialog box appears.

o

]
Digital Photo Mavigator

4 seclect [Keyspan USB DB9]* for connecting port

and click [OK] Digital Photo Navigator 1.0
Digital Photo Navigator starts. Port selection
o If you start Dlgltal PhOtO NaVigatOl’ at the fi rst time, Please, select conneting port.
a “pictures000” folder for saving images is SR TS e R
automatically created in the [Digital Photo KeyspanUsoBo |5 [__ok |

Navigator 1.0] folder. N )
% Th f . dff d d If not connected to serial device, press "Quit" button.
e name of connecting port may differ depe